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Preface

This VBPresenter User Guide is written for anyone who will be using or evaluating 
VBPresenter. VBPresenter is an add-in for Microsoft PowerPoint that lets you create and 
record live multimedia presentations using the standard Microsoft PowerPoint application 
that is included with the current versions (at this writing) of Microsoft Office. VBPresenter is 
created and supported by VBrick. If you have VBrick WM (Windows Media) on your 
network, VBPresenter can add streaming video to your multimedia PowerPoint presentations 
in a matter of minutes.

VBPresenter v2.x works with VBrick's WM or MPEG-4 appliances and uses the Windows 
Media Player interface. VBPresenter v3.0 supports VBrick WM video only. It delivers an 
advanced interactive viewer interface using Microsoft's Silverlight technology.

Organization

Getting Help
If you need help, or more information about any topic, use the online help system. The 
online help is cross-referenced and searchable and can usually find the information you need 
in a few seconds. Use the tree controls in the left pane to open documents and the up and 
down arrows in the right pane to page through them. Use the Search box to find specific 
information. Simply enter one or more words in the box and press Enter. The search results 
will return pages that have all of the words you entered highlighted in yellow (Internet 
Explorer only). The Search box is not case-sensitive and does not recognize articles (a, an, or 
the), operators (+ and – ), or quotation marks. You can narrow the search by adding words. If 
you can't find the information you need from the online help, or from your certified VBrick 
reseller, you can contact VBrick Support Services on the web. Support Services will make 

Note VBPresenter v3.0 requires VBDNA v4.2 or above for direct streaming from a WM 
appliance to viewers. Earlier versions of firmware are acceptable when streaming 
via a service or from a Windows Media Server.

Getting Started Explains how to install and configure the add-in. It also describes 
how to choose a web server and how to configure the add-in with 
an external configuration file.

Using VBPresenter Explains how to use VBPresenter functionality to provide live 
streaming video with your PowerPoint presentations.

Best Practices Explains some of the techniques you can use to create effective 
presentations including managing bandwidth and guidelines for 
your PowerPoint presentations.

VBPresenter with M
CS

Explains how to use VBPresenter with VBrick's MCS Portal Server.

Troubleshooting Provides answers to common problems and frequently asked 
questions about VBPresenter configuration and usage.

http://www.vbrick.com/support
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every effort to answer your technical questions in 24 business hours or less. Note that all 
VBrick product documentation is posted on the web at www.vbrick.com/documentation

Font Conventions
Arial bold is used to describe dialog boxes and menu choices, for example: Start > All 
Programs > VBrick
Green Courier fixed-width font is used for code elements (C++, HTML) as well as 
filenames, directories, etc.

Black Courier fixed-width font is used to indicate user input in keyboard commands, 
scripts, etc.

Folder names and user examples are displayed in this sans serif font.

Folder names and user input are displayed in this bold sans serif font.

Italics are used to emphasize specific words or phrases.

Printer-Friendly
Click on the link below to print a hard copy of this document in printer-friendly format. For best 
viewing, open and resize the document using the magnification box at the bottom of the 
Acrobat Reader window.

VBPresenter User Guide

VBPresenter Release Notes

VBPresenterUserGuide.pdf
http://www.adobe.com/products/acrobat/readstep.html
http://www.vbrick.com/documentation
VBPresenterReleaseNotes.pdf
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Chapter 1

Getting Started
Topics in this chapter

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Software Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
VBPresenter Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Configuring a Web Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Overview
The VBPresenter PowerPoint Add-In is used to give and record live multimedia 
presentations using conventional Microsoft PowerPoint. It operates in both PowerPoint 
Normal view and Slide Show view. The add-in converts your current PowerPoint 
presentation, uploads it and specially formatted viewing pages to your web server, and 
communicates with a target VBrick Windows Media appliance. This means viewers can see 
your live video, hear your live audio, and watch your live fully synchronized PowerPoint slides 
and web pages. During a live presentation, your audience may ask you questions via the 
Asking Questions feature.

Figure 1.  VBPresenter Recorded Presentation

The add-in generates two viewing pages, one for conventional Internet viewing (unicast) and 
one for local viewing in an enterprise network (multicast). The system allows a presenter to 
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reach thousands of local viewers without excessive wide area network bandwidth usage, and 
also reach a world-wide Internet audience. You can use a VBrick Reflector, a Windows Media 
server or a hosting service to replicate the VBPresenter video feed for remote viewers. 
Hosting services are available from VBrick partner PowerStream and other vendors.

An important innovation with this add-in tool is that PowerPoint operates normally while it 
communicates with your VBrick and manages the online presentation process. Presenters 
who are already familiar with PowerPoint need not change their normal behavior. In 
PowerPoint Normal view, the add-in keeps perfect synchronization with your VBrick audio/
video, but also allows you to receive live questions from your audience via built-in "instant 
messages." In a presentation venue, you can connect a projector to your computer to show 
your PowerPoint material to your audience normally. The add-in tool bar is not visible during 
PowerPoint Slide Show mode, but it silently controls your live presentation online. The add-
in software will record your live VBrick WM presentation and publish it on your web server 
for instant on-demand viewing.

Viewing Pages

The viewing page for live presentations displays the Ask Question dialog, while the same 
page for viewing stored presentations displays a Navigate button that enables thumbnail 
image viewing and selection. The viewing page also provides an option for viewing closed 
captions (if they are available). Clicking on the slide image or the video smoothly swaps and 
expands one or the other. Mousing over the slide or the video will display (or hide) the 
control buttons. When the video is expanded, the buttons may be hidden: click on the slide to 
reduce the video and expose the buttons.

Stop and Play are always available; Pause is only functional for stored video. The Reference 
button displays any uploaded reference material via a popup window. The Full Screen button 
opens the video/slide in full screen mode. Clicking on the screen will swap which one is full 
screen and which one is shown as an insert in the upper-left corner of the viewer's screen. 
The Ext Video button launches a popup resizable video viewer using Windows Media Player 
(Windows PCs only). The external player has a slide bar for granular navigation of stored 
presentations.

The Ext Slides button launches a popup resizable slide viewer. Both the Ext Video and Ext 
Slide viewers maintain synchronization with the viewing page and with each other. The 
external viewers are particularly useful for dual-screen monitor setups because you can drag 
the video to one screen and the slides to another. The Navigate button displays the slides 
used in the presentation. Clicking on any slide will cause the video to play at the position 
where the presenter showed it.

Viewing Page Addresses

The home page for presentations is http://yourServer/yourAccount/index.asp. This page 
displays Click To View Live Presentation - [PowerPoint Name] whenever you are online. 
This link is not shown when you are offline. You can also navigate to your viewing page using 
http://yourServer/yourAccount/PowerPoint Name or by using the link shown in 
VBPresenter after uploading your live or stored presentation. When you publish a recorded 
presentation, it will be listed on the primary viewing page with an image of your first slide, 
the title, and the upload date. You can sort the list by clicking on the column heading.
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About Logins and Passwords

Viewers of live presentations are asked to login. This establishes their identity so that the 
presenter knows who is viewing and who is asking questions. Viewers of recorded 
presentations are not asked to login. When uploading a new presentation, the presenter may 
assign a password. This password must be entered correctly by anyone wishing to view the 
presentation.

When uploading (that is "publishing") a recorded presentation, the presenter may assign a 
password. This password may be different from the one used for a live presentation. This 
password must be entered correctly by potential viewers. Thus you have a reasonable 
assurance that if you publish recorded presentations, they cannot be viewed by unauthorized 
viewers even though they are listed on the home page.

Managing Presentations

You can manage presentations by navigating to the VBPresenter Setup window and selecting 
Manage on your web server. Simply delete any folder you no longer wish to retain (the folder 
name is always the name of the original PowerPoint file). Note that within each folder, there 
may be the following files:

• Live.txt – tells the home page that this is the current live presentation. If you fail to select 
Offline, this file will remain on the server and you can manually delete it (or simply open 
that presentation again and select Offline).

• Recorded.txt – tells the home page to list this presentation. If you wish to retain a 
recorded presentation but not list it on the home page, simply delete this file.

Software Installation
It only takes a few minutes to install VBPresenter. Before installing VBPresenter, close 
PowerPoint and remove any previous instances of VBPresenter using Add or Remove 
Programs on the Control Panel. Note that if you have previously defined configuration files 
created with the VBPresenter Admin tool, they are automatically saved when you upgrade.

To install VBPresenter:

1. Insert the VBPresenter Product CD in your computer.
2. Navigate to the "VBPresenter Software" page, double-click on the setup program, and 

follow the online instructions. Click Finish when done.
3. After running the setup program, open PowerPoint and verify that the VBPresenter 

toolbar (see below) is present. If not, go to View > Toolbars and select VBrick 
VBPresenter.

4. If prompted by PowerPoint, select Enable Macros and Initialize ActiveX controls.

Note When using VBPresenter with the MCS Portal Server, passwords are not used for 
presentations. Instead the Portal Server access control system is used to prevent 
unauthorized access.

Note Macintosh viewers must install Windows Media Player in order to view WM 
presentations in Safari or Firefox.
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VBPresenter Toolbar

When the add-in is installed, it will show up as a new PowerPoint toolbar. By default, the 
VBrick VBPresenter toolbar will be loaded automatically each time you open PowerPoint. 
You can dock or undock the toolbar by simply dragging it to the desired location. Mouse over 
any tool to see the tool tip text. VBPresenter functionality is explained in more detail in 
Using VBPresenter Tools on page 23.

Table 1.  VBPresenter Tools

Icon Description

Launches VBPresenter Setup window.

Uploads the current PowerPoint presentation to the specified web 
server

Sends a pre-formatted email message that you can use to launch a 
presentation. It includes a unicast URL and a multicast URL.

Use to monitor the video being viewed or recorded, or to open 
the current presentation. When you monitor the video being 
recorded, it is low delay without audio.

Set the VBPresenter to LIVE ONLINE or OFFLINE.

This icon is displayed only when VBPresenter is LIVE ONLINE.

Set recording to START or STOP.

This icon is displayed only when a recording is in progress.

Show web page and conduct guided web browsing.

Conduct audience polling. 
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**A5 This is answer 5.

When you are finished creating the poll (by completing the window manually or by using the 
notes pane in PowerPoint as explained above), click Send Poll to send the questions and 
answers to your audience in real time. After you press Send Poll, you are ready to receive the 
realtime poll results on the following screen.

Responses are shown in realtime and in graphical form each time you press the Get 
Responses/Refresh button. The results show the number of responses for each answer and 
the total number of responses. You can save your poll results to a file (web page) on your 
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computer by selecting Save Poll Results. The poll results are saved on your computer in the 
same folder as your slides.

Showing Live Poll Results
When giving a live presentation, enter the following command in the notes area to share the 
poll results with the entire audience. Use this feature with care. It displays the results of all 
polls for the current presentation.

**SHOWPOLL

Showing Stored Polled Results
Published presentations can include multiple-choice tests. The test results are automatically 
tabulated and include the optional entered name of each viewer. The ability to get poll/test 
results from stored presentations means that you can publish a training presentation, give 
students a special name for viewing it, and get that student's time-stamped test results at any 
time. Similarly, in a marketing program, you can continuously collect and tabulate the results 
of customer surveys. Poll results from stored presentations are available online by accessing 
getpoll.asp. This page is saved in the same directory as your published presentation, for 
example:

http://serverIPaddress/remotedirectory/original_ppt_name/getpoll.asp

Figure 11.  Sample Poll Results

Add References

Use this window to add or remove reference material that will be available to end users. You 
can select and upload reference material, for example PDFs, Word files, Excel spreadsheets, 
video files, Flash demos, etc. Simply browse to the items stored anywhere on your network 
and populate the window. Since each upload removes the contents of the previous upload be 

Note You may want to include a page in your PowerPoint presentation with text that says 
Please Take A Poll and include the poll questions and answers on this page's notes 
area. When the person giving the presentation reaches this page, they will know that a 
poll is available. Audience polling is very useful to ensure your audience is paying 
attention and is grasping difficult concepts. If the results of your poll indicates a lack 
of understanding, you can quick backtrack and cover the information in more detail.
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sure to upload all of your items at once. After you click Upload, confirm the action and wait 
for an Upload Complete message before closing the window.

Displaying Full Screen Video

Enter the following command in the notes panel to hide the PowerPoint slide and switch the 
video panel only on each viewers monitor to full screen. It stays at full screen until you select 
another slide. In full screen mode, the slide is shown as an insert.

**FULLSCREENVIDEO

Recording a Presentation

• For best results, you should linger on the last slide of any presentation for a few 
moments after you are done to accommodate the delay in the video and ensure your last 
slide is recorded. 

• The built-in recorder is limited to recording three hours. If you plan to record a 
presentation that is longer you should break up the PowerPoint into multiple 
presentations (e.g. mypresentation1.ppt, mypresentation2.ppt, etc.). Longer 
presentations may be too large to manage as a single file.

• You, or someone else, may also record your live video presentation complete with all 
slides using VBrick's StreamPlayer Plus. If you wish to integrate such an 
independently-recorded WM video file into your presentation, be sure to name it the 
same as your PowerPoint file. Give your live presentation using VBPresenter while you 
record the live video using StreamPlayer Plus. When you are done with your live 
presentation, start again with the same PowerPoint and record a new one-minute 
presentation using VBPresenter and publish it (this ensures all of the archive viewing 
pages are created). Next, log into your server via the Manage button and replace the 
one-minute file with your larger file. This technique is useful if you create a second 
(backup) copy of the live presentation video which is recorded via local multicast. The 
VBPresenter recording is done using the same URL that your viewers are using and may 
be subject to Internet issues, while your local multicast is likely very reliable.

The following paragraphs provide useful information about recording and viewing 
presentations. Remember, you must be LIVE ONLINE before you can record a presentation. 
Select Record START in the toolbar, and confirm, to begin recording. Actual recording 
begins a few seconds after you press START when the red "record" icon is shown on the 
toolbar.
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• The recorded video file will have the same name as the PowerPoint presentation, and the 
file will be located in a folder with the PowerPoint presentation name. For example, if 
your PowerPoint file is called myshow.ppt and it is in My Documents then the video file 
will be My Documents/myshow/myshow.wmv.

• You can view your presentation, after publishing, by right-clicking on the Presentation 
Archive URL at the bottom of the "publish" window. You can also click Make Local File 
and view the recorded presentation by opening play.htm (which is located in the same 
folder as the PowerPoint presentation) in Internet Explorer. Tip: you can zip the entire 
folder and send it to someone or put it on a CD. They need only click on play.htm to 
view the presentation. You can also upload the entire folder to a web server. Viewers can 
view your recorded video presentation via "progressive download" from any web 
server—they just enter (or click on your hyperlink) the URL to the folder name.

• The recorded file will contain references to all slides as they were presented. This means 
that you can instantly post recorded presentations on a video server for instant video on 
demand.

• Your Video Recording URL (see Selecting a Video Viewing URL on page 10) must be set 
correctly. It is often the same as the Video Viewing URL, but you can set it to a local 
multicast, or set it to your local VBrick server while your Video Viewing URL is the URL 
of a reflector server.

Publishing a Recorded Presentation

You can instantly publish your recorded presentation to your web server or to a streaming 
server by selecting Publish Recorded Presentation on the VBpresenter toolbar. When the 
dialog window (below left) is displayed, click Upload to actually publish your presentation to 
the web server. You can launch the presentation after an upload by right-clicking on the 
Presentation Archive URL at the bottom of the window. Click Make Local File to copy the 
presentation files to the same local folder as your PowerPoint presentation. To play a 
presentation locally, navigate to the corresponding local folder and click play.htm.

The upload function will copy your recorded video to your web server or streaming server 
and will create a specially formatted viewing page on your web server (see Automatically 
Listing Recorded Presentations below). Viewing the recording will occur via "progressive 

Note The Make Local File functionality is supported on WM appliances only.
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download" from your web server or via a stream from your streaming server. When you 
publish your recorded presentation, viewers will see exactly the same presentation that you 
gave live, except they cannot ask questions. They can rapidly navigate by viewing and clicking 
View Thumbnails after the progressive download is complete.

For example, if you give a live presentation using myshow.ppt, your live URL will be 
/myshow. If you record this live presentation and publish it, the recorded presentation URL 
will be /myshow. If you upload a "new" presentation with the name myshow, you will replace 
any previous uses of this presentation name (either live or stored). To avoid any confusion, 
always rename your PowerPoint file to something meaningful and unique prior to uploading.

Re-Publishing a Recorded Presentation
If you delete the presentation from your server and if it still exists on your computer, you can 
publish it again. Simply open the same PowerPoint file, upload the presentation, then publish 
it. Video files are typically very large and you will need to be patient during the upload. Be 
sure you have adequate disk space on your web server before you begin. The viewing URL will 
be displayed after upload is complete.

Automatically Listing Recorded Presentations

A listing of all of your published presentations is automatically available from your web 
server. Presentations are automatically published to the root level of the server. To access the 
archive list, simply enter http://serveraddress/remotedirectory in your browser. For example 
if your sever is myserver and your directory is mydir then the viewing URL is http://

myserver/mydir. Live presentations do not appear in this list (for privacy). You can remove a 
stored presentation from the list, without deleting it, by logging in to your server and deleting 
the file called 1.stm from the presentation folder. As shown below, a thumbnail of each 
presentation is shown on the left and the title and date are shown on the right. Click on the 
thumbnail or the title to launch the presentation. Click on Presentation Title or Date 
headings to sort the presentations. This page provides an easy way to view and manage your 
presentations.

Note When you publish your recorded presentation, the same URL that was used to view 
your live presentation is used to view your recorded presentation. This is convenient 
in most cases. However, be careful not to upload a new presentation with the same 
name after you have published your recorded presentation. If you do, you will replace 
the recording with your new live presentation.



34 © 2008 VBrick Systems, Inc.

Figure 12.  Auto-Generated "Presentations" Page
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Delivering Effective Presentations

Basic Guidelines

• A WM appliance running supports widescreen mode. If you connect a widescreen video 
camera to the appliance, viewers will see widescreen video on their PCs. This is ideal for 
showing two or more presenters, or a panel discussion, at the same time.

• The URL of your presentation is the name of your PowerPoint file. Keep your 
PowerPoint file names short and easy to enter. For example, change my sales 

presentation for january.ppt to something like JanuarySales.ppt. Remember, your 
presentation is listed using the PowerPoint file name so you will want the file name to be 
informational.

• To avoid potential issues with browsers and hyperlinks, remove any leading or embedded 
spaces in your PowerPoint file name before uploading the presentation.

•  You may wish to remind viewers to disable any popup blockers, and/or to configure 
their Internet Explorer browser to allow popups from your server.

• The first slide in your presentation may not be displayed if you are already online. We 
recommend that when you start your presentation you go Online, or that you advance to 
slide two and then go back to slide one. It is a good idea to duplicate the "first slide" in 
your presentation so that slide one and slide two are identical).

• After you have uploaded a presentation, you do not need to upload it again unless it has 
changed. The VBrick PowerPoint Add-In will automatically select the current 
presentation. This means that you can switch PowerPoint files, even in the middle of a 
live presentation as long as the presentation has been previously uploaded, and your 
audience will always be seeing the right slides (as long as the PowerPoint file you switch 
to is the one you have previously uploaded). However, you must not switch presentations 
if you are recording.

• Use as much light as possible! All video looks better and more professional when it is 
well lit and you use a good quality camera.

•  Unless you have a local audience, look at the camera as much as possible.
•  When you look to your left, your audience will see your head turn toward the displayed 

slide and you can use this fact to enhance the viewing experience. Your audience will 
naturally follow your eyes. Rather than having your computer screen in front of you, 
place it to your left. Look at the camera most of the time—when you turn your head to 
the left to view a slide, your audience will see you looking in the correct direction. This is 
often more pleasing than seeing you look down toward your computer.
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•  You can switch the video input to your VBrick by clicking the Composite or S-Video 
buttons on the Setup window or by selecting Video 1 or Video 2 on the toolbar. This is 
very useful for a professional appearance: Your camera might be connected to the 
VBrick composite input and some other video source (e.g. a DVD player) might be 
connected to the S-Video input and you end your presentation by switching to some live 
video banner. Switching inputs during your presentation can also be used to show your 
audience other video sources. Note that audio does not switch and this technique 
presupposes that your second video source has no audio, or that the audio is mixed with 
your microphone audio.

• Use a good quality microphone and preamplifer. The VBrick accepts "line level" audio 
in, such as the output of a wireless microphone receiver or the "line level" output from 
your camera, VCR, DVD player, TV tuner, etc. You can typically use your camcorder 
with its built-in microphone. Removing the tape will often allow the camcorder to 
operate without automatically shutting down after a few minutes.

• Delete old presentations from your server. You will want to delete old presentations to 
save disk space, or to ensure privacy. Remember, if you upload presentation "A," and 
then upload presentation "B," a viewer can see your current live presentation by viewing 
either "A" or "B." If you record presentation "A" and then publish it, then a viewer of 
presentation "A" cannot see your current live presentation. If you are concerned about 
privacy, follow this rule: delete any presentation that you have not recorded and published.

•  Again, your PowerPoint file name is the key. If you are concerned about privacy, use an 
obscure name. Someone might guess a presentation named sales, but they would likely 
not be able to guess sales_xy84q.

•  If you are sending your video via multicast, you should disable the VBrick Announce 
SAP in IWS to provide better privacy of your live video. To do this, launch IWS, then go 
to Configuration: Encoder > Announce (SAP) and disable Transmit.

• You cannot right-click to copy a line from VBPresenter add-in. To copy a URL or other 
text, highlight the text and then use Ctrl-C and Ctrl-V to copy and paste.

• The presentation title displayed in the VBPresenter viewer is derived from the first 
PowerPoint slide in the presentation–not from the file name. For example, the title "My 
Presentation" is derived from the Slide 1 text box. This is the Title Slide in the default 
PowerPoint template. Keep this title short (less than 50 characters) so that it does not 
extend beyond the video area of the VBPresenter page.

PowerPoint Guidelines

There are no special requirements for your PowerPoint presentation and you can use existing 
PowerPoint files. However, the following guidelines will generally provide the best results:

• Do not use PowerPoint animations, audio or video, or other special features. If the slide 
has a "build" or animation, only the fully built slide will be displayed.

•  To conduct "builds" (where a new line is added to a bullet list each time you advance the 
presentation), use multiple slides. For example, create a slide with four lines. Copy this 
slide three times and delete line 4 from the third slide, delete lines 3 and 4 from the 
second slide, and delete line 2, 3 and 4 from the first slide. These four slides will now 
"build" as you go through your presentation.
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Managing Bandwidth Issues
A VBrick WM appliance is a server and can simultaneously deliver multicast to any number 
of viewers, push to a server for bandwidth scale, and deliver live video directly to 200 viewing 
clients via unicast up to about 50 Mbps. For delivering video to people outside your local area 
network (e.g. on the public Internet), you need two things: sufficient bandwidth (if you are 
streaming at 200 Kbps, you need 200 Kbps times the number of viewers), and your viewers 
need to be able to reach your source VBrick. Both of these typically mean you will configure 
the VBrick for an "outside" IP address. A VBrick that is outside your LAN and has an 
Internet address can be "reached" by global Internet viewers. But if a VBrick is "outside," 
then each potential "inside" local viewer would need to use your Internet access connection 
to view your video. With even a handful of "inside" viewers, this could easily saturate your 
Internet access connection, causing an unsatisfactory experience. While the source VBrick 
could also multicast, if it is "outside" your LAN then the multicast would not typically appear 
on your "inside" network.

To address this issue:

1. Place the source VBrick inside your network.
2. Configure your VBrick to multicast. Your live video can now be viewed within your LAN 

without bandwidth concerns.
3. Configure your VBrick to send live video to an "outside" reflector server. For Windows 

Media, this would be a Windows Media Server Since total Internet access bandwidth may 
also be an issue, you might chose to use a reflector service such as PowerStream for your 
Internet viewers.

Your outside Internet audience will view your presentation via http://yourserver/

PowerPointName, and your inside viewers will view via bandwidth-saving multicast via http://

yourserver/PowerPointName/multicast.htm. These addresses are automatically entered into 
an e-mail by the VBPresenter PowerPoint Add-In.

Typical Configurations

Using Unicast

The following drawing illustrates basic operation. The VBPresenter PowerPoint Add-In 
creates slides and uploads them to a web server. A VBrick delivers video over the public 
Internet to viewers. The video includes metadata that draws the slides from the web server as 
needed. In this case, the VBrick must be "outside" a LAN (i.e. it must have a public Internet 
address) and it can support up to 200 viewers.

Figure 13.  Typical Unicast Configuration
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Using Multicast

The following drawing illustrates multicast operation. In this case, the VBrick is also sending 
video via multicast on the local area network. Multicast has the advantage of not using any 
Internet access bandwidth for video, although the slides are delivered over the public Internet 
access connection (this is not a problem because the images are small). An important concept 
is that the LAN multicast and the Internet multicast occur simultaneously.
 

Figure 14.  Typical Multicast Configuration

Using a Reflector Server

The following drawing illustrates operation with a reflector server. In this case, the VBrick is 
sending a stream to a reflector server, perhaps a server with high bandwidth Internet access, 
and the reflector is sending the video to viewers. In this case, the number of viewers is equal 
to the capacity of the reflector. Moreover, the VBrick may be located virtually anywhere, 
including "inside" your network (e.g. in your office). It is also worth noting that reflector 
service billing is typically based on GBs of data transferred. The longer your presentations 
are streamed, the more charges you will incur.

Figure 15.  Typical Reflector Configuration



VBPresenter User Guide 39

Chapter 4

VBPresenter with MCS
Topics in this chapter

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Configuring a Web Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Configuring MCS for VBPresenter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Configuring VBPresenter for MCS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Upgrading MCS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Using VBPresenter with MCS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Overview
VBrick's EtherneTV Portal Server (MCS) can display live and stored rich media presentations 
created by VBPresenter. Live VBPresenter presentations are available for viewing from the 
Portal Server Live Broadcasts page; stored presentation are available from the Video Library 
page (and have a special icon). Like other content, rich media presentations can only be seen 
by those Portal Server viewers who have appropriate permissions. Before you can use 
VBPresenter with MCS, certain configuration steps are required on the Portal Server side. 
Once these steps are done, you can use the native functionality in VBPresenter to make live 
or stored presentations automatically available on the Portal Server. See "VBPresenter" in the 
Portal Server Admin Guide for an explanation of how to create a "presentation user" in MCS. 
This user is associated with VBPresenter and has specific permissions on the Portal Server.

Configuring a Web Server
Use one of the following procedures depending on whether which version of the ETV Portal 
Server you are using. Note that the Portal Server typically includes both server hardware and 
software but is also available as a software-only product. Web server configuration, as 
explained below, is the same regardless of which version you purchase.

Using MCS v4.1 as a Web Server

When installing a Portal Server (v4.1 or higher) on Windows 2003 Server, if a D: drive is 
present, a virtual directory is auto-created D:\VBrick\Presentations (for live presentations) and 
at D:\VBrick\MCSPresentations (for stored presentations). If a D: drive is not present, a virtual 

Note If you are using the ETV Portal Server to host VBPresentations, VBrick 
recommends upgrading to ETV Portal Server v4.1 or above. Portal Server v4.1 is 
easier to install and upgrade and lets you store presentations on the D: drive. If you 
previously configured MCS v4.0 using the default values suggested in the 
configuration procedure (see Using MCS v4.0 as a Web Server), VBPresenter will 
continue to work after an upgrade to v4.1. If however you used different folder 
names, for example, you will have to reconfigure the web server as explained in 
Upgrading from MCS 4.0 to 4.x.
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directory is auto-created at C:\Program Files\VBrick\MCS\Presentations (for live 
presentations) and at C:\Program Files\VBrick\MCS\MCSPresentations (for stored 
presentations).

MCS v4.1 automatically configures a web server for VBPresenter during software installation. 
It creates a user (Presentations), sets a local path, and performs various other configuration 
tasks. After installing the Portal Server software, VBrick strongly recommends you change 
the password (default = vbrick_86) for the Presentations user as a standard security 
precaution. Do not change the user name.

To change the password for the Presentations user:

1. Go to Start > Control Panel > Administrative Tools > Computer Management.
2. Click Local Users and Groups.
3. Right-click on user name Presentations and select Set Password.
4. Enter a new password and confirm.
5. Then right-click and select Properties.
6. On the General tab, uncheck User must change password at next logon 

(recommended).
7. Check User cannot change password and Password never expires (recommended).
8. Then click OK and Close.
9. To complete the VBPresenter setup, see Configuring MCS for VBPresenter on page 42 

and Configuring VBPresenter for MCS on page 43.

Using MCS v4.0 as a Web Server

VBrick MCS Portal Server runs on a standard Microsoft web server (Windows Server 2003) 
and is an appropriate server to use for your live presentations. You will need to set up an FTP 
account on the server. You cannot use the default MCS FTP account because it points to 
video "ingestion" for a VOD server. The following example shows how to configure MCS as 
a web server.

To configure MCS as a web server for VBPresenter:

1. Add a new user with Computer Management.
a. Go to Start > Control Panel > Administrative Tools > Computer Management.
b. Click Local Users and Groups.
c. Right-click on Users and select New User.
d. Create a user name (for example: Presentations) and set a password (for example: 

password). The user name must be the same name as the FTP virtual directory 
folder name.

e. Uncheck User must change password at next logon (recommended).
f. Check User cannot change password and Password never expires 

(recommended).
g. Click Create and then Close.
h. Select the Users folder and verify the new user was created.

Note When configuring an FTP account, the user name, the web and FTP virtual 
directory names, and the folder name where the uploaded presentations reside, 
must all have the same name.
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2. Set the local path for the new user.
a. Right-click on user Presentations and select Properties.
b. On the Profile tab in the Home folder, set the Local path to the Presentations 

folder: for example: C:\Program Files\VBrick\MCS\Presentations and click Apply and 
OK. (Note that this folder is automatically created during MCS installation.)

3. Set permissions for the Presentations folder in Windows Explorer.
a. Go to C:\Program Files\VBrick\MCS\Presentations.
b. Right-click and select Sharing and Security.
c. Click Share this folder, click Permissions, give Everyone Full Control, then click 

Apply and OK. (If the Share Name field is blank, type Presentations.)
d. On the Web Sharing tab, click Share this folder, and on the next window (click Edit 

Properties if necessary) click Read and Write. Then click OK and OK to exit.

4. Modify the Presentations virtual directory in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.
b. In left panel, double-click on local computer and then again on Web Sites.
c. Double-click on Default Website, then right-click on Presentations and select 

Properties.
d. On the Directory Security tab, click the Edit button under Authentication and 

access control and verify that Enable anonymous access is checked. 

5. Create a virtual directory on the Default FTP Site in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.
b. In left panel, double-click on local computer and then again on FTP Sites.
c. Right-click on Default FTP Site and select New > Virtual Directory.
d. Run the wizard and create new virtual directory called Presentations. 
e. Set the path to C:\Program Files\VBrick\MCS\Presentations and click Next.
f. Set the permissions for this folder to Read and Write. Click Next and Finish.
g. Right-click on the newly created Presentations folder and select Permissions.
h. Click Add, type Everyone in the text box, and click OK.
i. Give Read, Write, Read & Execute, and List Folder Contents permissions to 

Everyone and click OK.

6. In IIS, double-click on Web Service Extensions and verify that Active Server Pages are 
allowed.

7. Close the window and you are finished configuring a web server. To complete the 
VBPresenter setup, see Configuring MCS for VBPresenter on page 42 and Configuring 
VBPresenter for MCS on page 43.

Your goal is to set up an FTP account on the Windows server such that when a user enters 
the username/password, they are placed in a folder that is published by the web server. If you 
create a folder called mystuff, and place mypage.htm in the folder, then the page should be 
viewable on the network via http://ipAddress/mystuff/mypage.htm. Once setup, you will use 
this username/password and base URL (in this example, the base URL is http://ipAddress/

mystuff) as the server URL in VBPresenter). If you record your presentation, you can place 
all of the files on the web server so that the WM stream will be delivered via HTTP 
progressive download.
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Configuring MCS for VBPresenter

Configuring an MCS FTP User Account

The Portal Server's FTP User Name and FTP User Password must be set in the Admin 
console (Global Settings > Global Assignments) to the values that are configured in IIS. 
When a client logs on to the Portal Server's FTP account (for example from a Command 
Prompt window), this combination of FTP user name and password must place the user into 
the FTP root directory of the Portal Server. (This is not the same as the Presentations 
directory. The Presentations directory is a virtual directory in IIS. This directory is the root 
folder for live presentations only.) There is an MCS directory at the FTP root directory. Note 
that the entries made in the Admin console are stored in the Portal Server and do not actually 
configure IIS. These values must reflect what IIS has been configured for.

Configuring an MCS Presentation User

Perform the following configuration one time only in MCS so that VBPresenter can access the 
Portal Server. These steps will create a pseudo VBPresenter user who is associated with the 
authoring tool and has specific permissions on the Portal Server.

To create a presentation user:

1. Open the Admin Console and go to Users.
2. Add a user name (for example PresentationUser) and give this user the following 

permissions:
a. Add/Modify Live Channel Privileges – check the appropriate channels.
b. Add/Modify Live Programs Privileges – check the appropriate programs.
a. Allow Access to Specific VOD Servers – check the appropriate servers.
b. Allow Access to Specific VOD Content – check the appropriate folders.
c. Allow Content Publishing – check the appropriate folders.

3. Go to Global Settings > Global Assignments > Assign Presentations, select the user 
you created above (for example PresentationUser) as the New Presentations User, then 
click Submit. (Note that the Presentations Directory field in Portal Server v4.0 refers to 
the folder name under C:\Program Files\VBrick\MCS. If necessary, enter the folder name 
only in this field. Do not enter the complete path.)

Configuring for Live Presentations

The following steps must be performed to configure the Portal Server for each live 
presentation.

Note The MCS setup program creates an additional user name and password with an FTP 
Home directory in the Live Presentations folder on the MCS server. This User 
Name (Presentations) and password (vbrick_86 in MCS 4.2; Presentations in MCS 
4.2.1) are used in the FTP/Web Server section of the VBPresenter Setup window (see 
Figure 16).

Note In the ETV Portal Server v4.1, the Presentations directory is a virtual directory in 
IIS. This directory is the root folder for live presentations only. See the v4.1 Portal 
Server Admin Guide for more information.
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To configure the Portal Server for a live presentation:

1. Go to Global Settings > Program Names and add a program name (for example Live 

Presentation). Then use this same name in the MCS Program Name field in VBPresenter. 
This is the title that will be displayed on the Live Broadcasts page during a presentation.

2. If necessary, give your end users access to this live presentation. Go to Users > Add/
Modify Live Channel Privileges and select this Program Name.

Configuring for Stored Presentations

There is no additional configuration for stored presentations.

Configuring VBPresenter for MCS
When you are done, go to VBPresenter and configure the FTP server you defined above as 
shown in Figure 16. You may need to create a Presentations folder on the FTP/Web Server 
for your published presentations if not already present.

Figure 16.  Configuring VBPresenter for MCS

Hint To pre-configure a presentation, create a Program Name in advance on the Portal 
Server and assign Live Channel Privileges to users. Then use the same name in the 
MCS Program Name field in VBPresenter when giving the presentation. The MCS 
Program Name will be available on the Live Broadcasts page for any users who have 
permissions to view that channel

IP or Host MCS IP address or host name.

Username Default = Presentations. This user is created by MCS and used by 
VBPresenter to place content in the Presentations directory of MCS. 
(It is a Windows account user with a Home directory in the 
Presentations folder of the MCS server).
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Upgrading MCS
If you are using VBPresenter with MCS 4.0, you can use the following procedure to upgrade 
to MCS v4.x without affecting your existing presentations (4.x is 4.1 or higher).This 
procedure will preserve your existing presentations and let you create new ones with your 
existing file system and web server configuration. (Note that you will need to restart any live 
presentations currently in progress.)

Upgrading from MCS 4.0 to 4.x

If you are using the VBrick ETV Portal Server v4.0 to host your presentations, VBrick 
strongly recommends upgrading to ETV Portal Server v4.x. Portal Server v4.x is easier to 
install and upgrade and lets you store presentations on the D: drive for greater flexibility. If 
you installed VBPresenter with MCS 4.0, your live presentations will continue to work after 
upgrading to v4.x and will be saved on the C: drive. If a D: drive is present, live presentations 
will remain on the C: drive. Use the following procedure only if you want to move your live 
presentations to the D: drive. 

Stored presentations will not automatically work. You must manually copy any stored 
presentations from C:\Program Files\VBrick\MCS\MCSPresentations to 
D:\VBrick\MCSPresentations. No other configuration is required for stored presentations.

To move your live presentations from the C: drive to the D: drive:

1. Create the folder D:\VBrick\Presentations.
a. Go to Start > Control Panel > Administrative Tools > Computer Management.
b. Click Local Users and Groups.
c. Click on Users and in the right panel right-click on the Presentations user and select 

Properties.
d. On the Profile tab in the Home folder, set the Local path to the Presentations 

folder: for example: D:\VBrick\Presentations and click Apply and OK.
e. Go to C:\Program Files\VBrick\MCS\Presentations.
f. Right-click and select Sharing and Security. On the Sharing tab, select Do not 

share this folder.
g. On the Web Sharing tab, select Do not share this folder, and click OK.

2. Set permissions for the Presentations folder in Windows Explorer.
a. Go to D:\VBrick\Presentations.
b. Right-click and select Sharing and Security.
c. Click Share this folder, click Permissions, give Everyone Full Control, then click 

Apply and OK. (If the Share Name field is blank, type Presentations.)
d. On the Web Sharing tab, click Share this folder, and on the next window (click Edit 

Properties if necessary) click Read and Write. Then click OK and OK to exit.

3. Modify the Presentations virtual directory in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.

Password Default = vbrick_86

Rmt Dir Presentations

URL MCS IP address or host name/Presentations. For example:
http://<ipaddress or host name>/Presentations.
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b. In left panel, double-click on local computer and then again on Web Sites.
c. Double-click on Default Website, then right-click on Presentations and select 

Properties.
d. On the Directory Security tab, click the Edit button under Authentication and 

access control and verify that Enable anonymous access is checked. 

4. Modify the Default FTP Site in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.
b. In left panel, double-click on local computer and then again on FTP Sites.
c. Right-click on Presentations and select Properties.
d. On the Virtual Directory tab, set the path to D:\VBrick\Presentations and click OK.
e. Right-click on the Presentations folder and select Permissions.
f. Click Add, type Everyone in the text box, and click OK.
g. Give Read, Write, Read & Execute, and List Folder Contents permissions to 

Everyone and click OK.

5. In IIS, double-click on Web Service Extensions and verify that Active Server Pages are 
allowed.

6. Reboot the server.

7. Close the window and you are finished configuring a web server. To complete the 
VBPresenter setup, see Configuring MCS for VBPresenter on page 42 and Configuring 
VBPresenter for MCS on page 43.

Using VBPresenter with MCS

Launching a Presentation from MCS

The web server in VBPresenter can be configured with either a domain name or an IP 
address. If configured with an IP address, you must launch the MCS client using the IP 
address in order to view presentations successfully; if configured with a domain name, you 
must launch the MCS client using the domain name. You cannot mix-and-match domain 
names and IP addresses or Session Expired and Maximum Viewers Exceeded errors may be 
displayed by the Portal Server.

Note that you must launch a VBPresentation from MCS. You can only view the video on the 
local machine where VBPresenter is running. The Portal Server uses the special icon shown 
here for VBPresentations. You can launch presentations from the Portal Server in two ways: 
live presentations (those currently in progress) are available on the Live Broadcasts page; 
stored presentations (those which have been "published" to the Portal Server) are available 
on the Video Library page.
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Figure 17.  Launching a Presentation from the MCS Portal Server

To launch a presentation from the Portal Server:

1. Launch the Portal Server and go to the Live Broadcasts or Video Library page 
depending on whether the presentation is live or stored.

2. Click on the icon for any available presentation. The presentation will run and the slides 
will be automatically synchronized with the video.

Publishing a Presentation from MCS

You can instantly publish your recorded presentation to your web server or a streaming 
server by selecting Publish Recorded Presentation from the VBpresenter toolbar. If MCS is 
configured as your web server, you can set Stored Presentation Values that describe the 
video and are searchable in MCS. You can also set an Expiration date in the format: 
yyymmdd-hhmm.

Note If you are just joining a live presentation, the first slide may not be displayed on your 
computer until the presenter clicks on a new slide or begins the presentation by going 
LIVE ONLINE (or until the duration in seconds exceeds the Auto Refresh value).
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Common Problems

Problem Solution

No slides get uploaded to 
my server.

Can you access your FTP account via the Manage button in the toolbar? 
If no, then you don't have the correct address / username / password 
entered for your server, or your server is not set up correctly. 

What is the viewing 
URL? Can I view it while 
I give a presentation?

• The presentation URL is automatically listed in e-mail generator. 
Click on the e-mail icon to view.

• The presentation URL is your server address + /optional folder + /
PowerPoint file name.

• You can open a browser to view your presentation the same way as 
your audience on the same computer, but you would not want to do 
this during a presentation because it may confuse you. 

Everything seems to 
happen correctly, but 
when I change slides they 
are not shown.

• Be sure you have selected LIVE ONLINE.
• There may be some delay due to the network, reflector server (if 

any), and the player. You may need to wait up to 15 seconds, 
depending on your configuration, to see the slides change. 

• Did you remember to enable Meta Data on your VBrick 
configuration.?

• Each time you change your slide, the Meta Data field in your VBrick 
should be populated with a new URL. Does this occur? Did you set 
your VBrick username and password correctly?

• Can you access your VBrick via the Manage button? If no, you do 
not have the correct address / username / password entered, or the 
VBrick is not on the same network.

• Did you set the Remote Directory setting correctly for the FTP 
server?

I can't figure out what to 
enter for the viewing 
URL.

Open a browser and enter http://ServerAddress/remote dir/

presentationname/s001.jpg. You should see the image of your first 
slide. If you do, your viewing URL is this without the /
presentationname/s001.jpg.  If this does not work, then the server 
address and remote dir is not correct or your web server is not set up 
correctly. Your remote directory must publish web pages (e.g. web 
sharing enabled on the server). 
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Some viewers report the 
slides are not showing 
up.

If at least one viewer can see your video and your slides, the problem 
cannot be at your end. It is possible they have popup blockers enabled 
or they may have a problem with their computer. 

Some viewers report that 
the slides are cut off the 
screen.

The viewer's screen resolution is set too low. The screen resolution 
should be at least 1024 x 768. When you upload your slides, select a 
smaller size (choice is large, medium, small). Normally, you should use 
"medium". 

Local viewers are not 
seeing the video via the 
multicast page.

• Do you have multicast enabled on the VBrick? 
• Does your local network support multicast? 

Cannot view a saved 
presentation.

• Are you certain you recorded your presentation? There should be a 
new folder with your presentation name, and the folder is located 
under the same folder as your original PowerPoint file. This folder 
should have your video file.

• You should be able to view your presentation by opening (double-
click) index.htm in Internet Explorer. 

• You can upload the entire folder to a web server "as is" if you are 
using WM and viewers can see your stored presentation via 
progressive download. 

No video. • You must use the VBrick "Slot 1" 
• Can you see the video via conventional means (e.g. via Media Player 

by entering the VBrick URL)? 
• Did you enter the correct video URL on the setup screen? Paste this 

entry into Media Player...does it play? If not, your VBrick is not 
streaming or the URL is incorrect. If yes, then perhaps the URL is 
not reachable by your intended viewers. 

What happens if I change 
slides very quickly?

Your viewers will likely skip any slide that is not displayed on your 
computer for at least two seconds. 

Can I get live audience 
feedback?

Yes. Your server must support ASP. You can use other methods to 
receive live audience questions (for example e-mail or IM) but using a 
telephone conference bridge and speakerphone is usually a bad idea. 

Can I do slides only (no 
video)?

No. But you can chose to send very low rate video (e.g. 1 fps at 20 
Kbps) and turn off your camera and microphone. 

Can I use the MCS Portal 
Server?

• Yes. The MCS Portal Server runs on a standard Windows Web 
Server. You can upload your entire saved presentation folder to the 
server if your video is WM format and view the saved presentation. 

Problem Solution
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Can I turn off the "click" 
sound each time a slide 
changes?

Yes. This is a Windows setting on your computer. Go to Start > Control 
Panel > Sounds and Audio Devices and set Complete Navigation to 
None.

How can I give a 
presentation to all my 
local employees and also 
to remote employees via 
the public Internet?

1. Configure your VBrick on your LAN.
2. Set your VBrick to multicast locally.
3. Set your VBrick to also stream to a reflector (for WM this is a WM 

server).
4. Send an e-mail to invite your participants using the built-in e-mail 

utility. This e-mail includes both viewing URLs. 

Can I edit the recorded 
video?

Yes. For WM you can use many third-party editors, or the free Movie 
Maker from Microsoft.

I recorded a presentation 
on my computer, then 
published it. By mistake, 
I deleted it. How can I 
restore it to the server?

Your recording still exists on your computer, so you simply need to 
upload it to your server. You might be able to do this via the Publish 
button if you have not created a more recent presentation. You can also 
open Setup and click on Manage for your web server. This will open a 
FTP window to your web server. Simply drag-and-drop your entire 
presentation folder to the server. The presentation folder is in the same 
directory as your original PowerPoint file and the folder has the same 
name as your original PowerPoint file. 

Can I use my corporate 
web server?

Usually. If your corporate web server is on a hosted (third party) 
Internet web server, you may or may not be able to add FTP accounts. 
If your FTP account puts you in to a top level directory (e.g. above 
"www" or above "htdocs"), then you must set the "Rmt Dir" field in 
setup to your target subdirectory. 

Multicast is enabled 
when I go online.

If you are not using multicast, set your VBrick multicast address to 
Loopback so that turning it on does not matter.

Problem Solution
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Frequently Asked Questions

Question Answer

What type of web server 
is required? 

VBPresenter uses ASP for certain functions, so your web server must be 
Microsoft (IIS). If you are using VBrick internal hard drive (WM models 
only), then VBPresenter formats the pages not to use certain functions 
and ASP is not used. Because the VBrick web server does not support 
ASP, Questions, Polling, and certain other features are not supported.

Do I need a streaming 
server? 

Maybe. For live video, see "When do I need a reflector service? "
For stored video, VBPresenter supports "progressive download" for 
WM video types and will publish your recording on your web server if 
you select Progressive Download. You should use a streaming server 
for larger video files and/or when you expect more than a few viewers.

Does VBPresenter work 
with VBrick's MCS / 
ETV system?

Yes. For WM video type, you must have a Windows Media server for 
stored video files.

What is the difference in 
operation using a 
conventional web server 
and VBrick MCS / ETV 
system?

When you use VBPresenter with a web server, the viewing URL of the 
live presentation is the PowerPoint file name. When you give a live 
presentation via MCS, you set up a special "channel" name that appears 
in the MCS live program guide. This allows a presenter to always have 
the same "channel" name (for example, "History 101" or "CEO 
Address") regardless of the PowerPoint name. For recorded 
presentations, MCS allows the presenter to enter a title, keywords (for 
searching), expiration date and publishing folder.
When used with a conventional web server, both the live and recorded 
presentation name is always the name of the original PowerPoint file.
VBrick MCS/ETV System provides granular permissions, allow you to 
limit the viewing to only authorized parties. When used with a 
conventional web server, the presenter may assign a password. When 
used with MCS / ETV System, no password is entered because the 
permission to view it is configured by the MCS (e.g. permissions are 
established by MCS at the folder level).

What happens when I 
publish a live 
presentation? 

VBPresenter creates special viewing pages based on the entries in the 
setup screen and uploads these to your web server (or MCS).

What happens when I 
publish a recorded 
presentation?

VBPresenter creates special viewing pages based on entries in the setup 
screen and uploads these to your web server (or MCS). VBPresenter 
uploads your recorded video file to your web server (if progressive 
download is selected) or your streaming server (if streaming server is 
selected). VBPresenter assumes you have first conducted a live 
presentation and subsequently modifies it by publishing the recording. 

Why don't the viewer's 
slides change? 

You have not published them. Are they present on your web server? 
You have not set the VBrick Metadata Enable You may need to set this 
in three places: under "video", under "server" and under "push". You 
have not correctly entered the VBrick IP address, username, and 
password.
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How do I install or 
remove VBPresenter?

To install, just run the setup program. To remove, run the setup 
program again and select "remove", or use the Windows control panel. 
With VBPresenter 2.1 and above, you do not use Tools > Addin. 
VBPresenter does not appear in the PowerPoint Add-In toolbar, but it 
does appear as a "customize" option. 

What is "PowerStream"? PowerStream is a company that provides WM reflecting service and 
VBPresenter web hosting. You may use other reflector services, such as 
Limelight, VitalStream, etc. but these services do not support the web 
server features and you will need to find a web server for the slides and 
html pages that VBPresenter uploads.

When do I need a 
reflector service? 

You need a reflector service if you wish to reach viewers on the public 
Internet, if you don't have an outside IP address, and/or if you do not 
have sufficient bandwidth to reach the number of viewers you wish. 
Most small companies will need a reflector service if they wish to reach 
viewing on the public Internet. Many larger companies have sufficient 
bandwidth or they have their own reflector.

Are Apple and Linux 
computers supported? 

Yes.

What is the difference 
between the "Video 
Viewing URL" and the 
"Video Recording URL"?

 The Video Viewing URL is the URL that is used by your audience for 
viewing the video (within the web page). The Video Recording URL is 
the URL that VBPresenter uses to (optionally) record the video. Because 
your VBrick is physically close to you and is a streaming server, you can 
have a better recording if you elect to record directly from it rather than 
from the Video Viewing URL which might be the URL of a reflecting 
server. 

How many local viewers 
can I have?

Unlimited. Both the VBrick WM appliance provides direct IP Multicast, 
enabling a virtually unlimited number of local viewers. Of course, your 
web server will need to support an equal number of sessions.

Can I show my live 
computer screen?

Yes. VBrick supports two video inputs and VBPresenter give you a 
built-in video switch. Connect the video output of your computer (if 
available) to one input and your camera to the other input. Show your 
live desktop by selecting the alternate video input.
Depending your preference, you might use 640 x 480 resolution for your 
VBrick WM appliance and remind your viewers that they may use the 
external video viewer if they would like a larger viewer. You can use the 
optional "VBPresenter Screen Capture" tool found on 
www.videoalive.com. This allows you simply press one button to capture 
your desktop and share it with your audience.

Why is a live presentation 
listed on the VBrick MCS 
even after I have closed 
PowerPoint? 

You must select OFFLINE before exiting PowerPoint. You can restart 
PowerPoint using the same presentation and select OFFLINE to remove 
the listing.

Question Answer

http://www.videoalive.com
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Can I make a 
presentation that I can 
put on CD as a hand out?

Yes, for WM video type. When you create and record a presentation, it is 
located on your computer in a folder with the same name as the 
PowerPoint file. When you publish a presentation, you may also select 
Make Local File. Simply open the file called play.htm to view the 
presentation locally. Copy the folder to a CD and when you double-click 
on play.htm or drag it to Internet Explorer, your presentation will play 
(WM only).

Can I save the audience 
questions?

Yes. Press the Save History button on the audience questions viewer. 
You can also save just the "attendance" list.

Can I have multiple 
configurations?

Yes, as many as you like. VBPresenter Administration Utility allows you 
to create configuration files and they may be selected in the 
VBPresenter setup screen. You may elect to Hide Setup Button in 
VBPresenter when you create a configuration file. If you do this, then 
the VBPresenter user cannot access the setup, thus preventing the 
exposure of your server parameters.

Can I control or limit the 
number of live viewers?

Yes. Simply set the Max. Viewers. You can also set the maximum 
number of sessions that your VBrick will support. This is a good way to 
ensure your live video only reaches your intended audience: if you know 
you have invited only 20 people, then set you limit to 20. 

Can I integrate 
spreadsheets, word 
documents, and other 
material in my 
presentation? 

Yes, in multiple ways. You can copy the material into a PowerPoint slide 
and proceed normally. You can upload the material as "Reference", 
allowing your audience to obtain copies of virtually anything you post. 
You can use "Guided Web Browsing" to show any reference material to 
your audience (if it can be displayed in a browser).
You can use "VBPresenter Screen Capture" tool. This tool uses your 
current VBPresenter settings, captures your desktop image, and sends it 
to your audience in real time. For example, you would minimize 
PowerPoint, open up some other application, and press "Alt" to send an 
image of your desktop to your audience.

Can I integrate additional 
video into my 
presentation?

Yes. Simply type in the URL of the target video (.wmv, .mov, .sfw, etc.) 
using the Guided Web Browsing feature. You can also use the Guided 
Web Browsing feature to navigate to a web page that has video, 
animations, or other graphical elements embedded in it.

Can I customize the 
viewer interface?

Yes. You can insert you own logo in place of the VBrick logo.

Do viewers have to "log 
off"? What happens if 
they do not?

Viewers should log out when they leave. But if they just close their 
browser, the system logs them off automatically. If they just shut off 
their computer, then the log out will not occur. In this case, the system 
is configured with a timeout that you set in VBPresenter. The timeout 
should be set to at least the expected duration of your live presentation. 
If it is too short, then viewers will be unable to ask questions without 
logging out and then logging back in.

Question Answer
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Some links in web pages 
don't navigate viewers 
when using Guided Web 
Browsing. Why?

Guided Web Browsing only supports conventional web links. Some web 
sites use Javascript, Flash, or similar techniques that are not supported 
by VBPresenter. Prior to your presentation, you should verify the links 
you plan to use.

Why doesn't my first 
slide show up? 

Your first slide will be displayed under the following conditions: You 
select ONLINE. If you are already ONLINE, then the slides change only 
when you select (change) them in PowerPoint. If you set the Auto 
Refresh to 60 seconds, then the current slide will be refreshed every 60 
seconds. This is very useful to accommodate viewers that tune-in late 
and where the presenter lingers on one slide for long periods. You can 
elect to have an additional copy of your first slide so that when you 
advance to it the viewers see it in real time.

Do viewers require any 
downloads or plugins?

No. Most viewers already have the necessary player components 
installed on their computers.

Can I move my 
presentation from one 
server to another? 

Yes, but currently this will require some hand-crafting of the code. A 
utility will soon be available to make moving presentations between 
servers simple.

Can I use dual monitors? Yes. Simply select Resizable Video and move it to one monitor. Select 
Resizable Slides and move it to the other monitor.

Simple troubleshooting 
tips 

When you press the server Manage button, it should open Internet 
Explorer and you should see any uploaded folders. If this does not 
happen, then your web server address, username, password, and/or 
remote directory are not set correctly OR your web server is not set up 
correctly.
When you press the VBrick Manage button, it should open Internet 
Explorer and you should see the VBrick management interface. If this 
does not happen, then your target VBrick is not on, you have not 
entered the correct IP address, or there is a network issue reaching the 
VBrick.
If using Streaming Server, when you press the Streaming Server 
Manage button, it should open Internet Explorer and you should see 
the contents of your streaming server. If this does not happen, then 
your streaming server address, username, password, and/or remote 
directory are not set correctly or your streaming server is not set up 
correctly.
When you are online and changing slides, the Metadata field of your 
VBrick should become populated (Configure: Encoder > Video). If this 
does not happen then you have not correctly set the VBrick IP address, 
username, password and/or, port or your VBrick is not set up correctly.

Question Answer
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Server Setup You know your web server is set up correctly when:
• You can open a FTP session to it using the server address, 

username/password.
• You can upload a html page to it.
• You can view the uploaded html page by opening Internet Explorer 

and entering http://ServerAddress/RemoteDirectory/
uploadedPage.html

• The server is Microsoft IIS and ASP is enabled.
• The server has write privilege both the FTP user and for the web 

user.
For VBrick MCS/ETV System, you should create a new virtual FTP site 
on the server and follow the instructions in the MCS setup instructions. 
It is important that each user has their own virtual site on the web 
server. If multiple users use the same account, then they share the live 
audience questions too (which can be very confusing). Technical: Each 
account will have its own global.asa. 

VBrick Setup You must setup your VBrick. Generally, you will set the streaming bit 
rate(s), the http push(es), the multicast address, and the server(s). If 
using a reflector service (e.g. PowerStream), set the HTTP Push as 
instructed by the service provider.
For general purpose streaming via the public Internet, you will want to 
ensure your streaming bit rate is one your viewers can support. Most 
DSL/Cable modem "broadband" users can receive at least 300 Kbps. To 
ensure the widest support, you might set your VBrick WM appliance for 
multiple bit rates (e.g. 200 Kbps, 500 Kbps, 1 Mbps). Configure your 
VBrick streaming server and/or HTTP push for 200 and 500 Kbps (if 
you have adequate outbound bandwidth) and configure your multicast 
to use the 1 Mbps rate. 

Question Answer
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